SOLARIZE YOUR SCHOOL

A Solar Energy System Design Challenge

TEAM MEMBERS
NAME 1, NAME 2, NAME 3
Table of Contents

Introduction .......................................................................................................................... 1

1. Research Design Factors .............................................................................................. 3

2. Design a Prototype Solar Array System ........................................................................... 5
   Step 1: Choose a Site and Import its Model ................................................................. 5
   Step 2: Analyze Solar Insolation Available for Your Site ............................................. 5
   Step 3: Note Obstructions .............................................................................................. 7
   Step 4: Keep Curb Appeal in Mind ............................................................................... 8
   Step 5: Avoid the Edge of the Roof ............................................................................. 8
   Step 6: Select a Brand of Solar Panels ......................................................................... 9
   Step 7: Design the PV System ..................................................................................... 10
      A. Optimize the orientation of solar panels ............................................................... 10
      B. Set the rack size ..................................................................................................... 10
      C. Set the base height for your racks ..................................................................... 11
      D. Pick a rack system (Optional) ............................................................................ 11
      E. Set tilt angle ........................................................................................................ 11
      F. Set azimuthal angle .............................................................................................. 11
      G. Produce a solar array design prototype ............................................................... 12

3. Test Your Solution ........................................................................................................ 13
   Part 2: Determine the Solar Offset of Your Design ...................................................... 13
   Part 3: Calculate the Total Project Cost ....................................................................... 14
   Part 4: Calculate Payback Period (Optional) ............................................................... 15

4. Redesign Your Solar Array System ............................................................................. 16

5. Document Your Work: Complete a Design Journal .................................................. 17
   Iteration 1 – Prototype ............................................................................................... 18
   Iteration 2 – Redesign ............................................................................................... 19
   Iteration 3 – Redesign ............................................................................................... 20

6. Communicate Your Results ....................................................................................... 21

Appendices ...................................................................................................................... 23
   Appendix 1. Site-Specific Design Requirements ......................................................... 23
   Appendix 2. How much electricity does a building consume annually? ....................... 24
Introduction

Scenario: Your local school board is launching an effort to investigate using solar energy instead of traditional, non-sustainable fossil fuels to provide the energy needs for your school. To determine the feasibility, and cost effectiveness, of converting to a surface-mounted PV solar panel system, the board is holding a competition, asking for bids from student teams in your class to design solar arrays that meet the following criteria:

1. **Solar offset**: The system should produce as much electricity as required to supply the annual consumption of the building.

2. **Return on Investment**: The payback period of the project should be as short as possible.

3. **Curb appeal**: The system must have minimal negative impact on the curb appeal— the attractiveness of a property and its surroundings when viewed from the street—of the school building.

There are a number of constraints you must keep in mind as you prepare your initial design:

**Constraints:**

1. **Budget**: The total cost of the system must not exceed the budget that your client is comfortable with.

2. **Existing structures**: Existing structures on the roof (e.g., ventilation hatches, HVAC modules) cannot be removed or covered.

3. **Fire code compliance.**
   a. There shall be a minimum 6-foot-wide (1.8 m) clear perimeter around the edges of the roof.
   b. Pathways shall be a straight line not less than 4 feet (1.3 m) away from rooftop structures.

4. **Rack base**: Solar panels are mounted on metal stands called racks. An attached racking system would be necessary if racks are tilted more than 15°. Attached racking systems can resist higher wind loads but also are more expensive to install. Ballasted racking systems would be used if tilt angle is less than 15°. The base height of a ballasted racking system should be less than 0.5 meters to support the weight of the system.

5. **Inter-row distance**: Racks should be spaced close enough to maximize the roof area but also far enough apart to minimize shading.
The process you will follow is one used by engineers and inventors and is helpful in solving many kinds of diverse problems. The steps in the process are shown in the diagram below.

The key difference between solving an ordinary problem and engineering a solution to a problem or producing a product is the yellow loop in the diagram above. When engineers or inventors produce a prototype, their work is just beginning! Problem solved? Not even close. Engineers strive to improve whatever they have produced and will spend countless hours (and money!) to get it exactly right. Thomas Edison and his team took his initial light-bulb prototype and tested more than 6,000 possible materials before finding a filament that would be durable but expensive (25 cents in 1879) before finding one that worked: carbonized bamboo. This engineering design principle, called optimization, requires engineers to be tenacious, relentless, and able to criticize their own work requires a different mindset: It’s not over until you think it’s the very best it can be.

Although your team won’t be required to optimize your design as many times as Edison did, you will need to make several iterations on your plan to make your solar array more energy efficient and/or economical.

The winning teams’ bid—the solar design Challenge winner—will submit a report demonstrating that their design produces the most electricity per year for the least amount of money, with the shortest payback period.

To design such a system you will need to consider a number of regulations—fire, electrical, and building codes—and a series of constraints as you work in Energy3D to create your plan. You will then evaluate the efficiency and cost of your initial design, called a prototype, and then you will strive to re-design and re-evaluate your solar array to optimize it. When you have achieved your design goals, you will submit your bid in the form of a report for your school board.

To successfully complete the Solar Design Challenge, your team must submit the following:

- A **Solar Challenge final report**.
- An **Energy3D Model** of your final design that shows the layout of the solar panels.
- A **Design Journal** that records the relevant information you gathered and your thought processes as you proceeded with your design iterations.
1. Research Design Factors

Your team has been given a problem (designing an effective PV solar panel system) and general requirements for the Challenge in front of you. Since you will be designing panel systems for a flat-roofed school, you will need to research and consider a number of factors in your design.

*Avoid obstructions* - Designing a solar array on a flat surface on a flat rooftop is like fitting puzzle pieces in an area limited by the roof edge while avoiding obstructions such as chimneys, vents, and heating and cooling equipment. There must be room for workers to walk on the roof in order to service or repair these structures.

*Avoid/Reduce shadows* - Also, any shade cast on a solar module from rooftop structures can greatly reduce the energy produced by the panel, especially when they are shadowed during peak hours from 10am to 2pm. Energy3D’s Calculate the Energy of the Day and Shadow tools allow you to see how obstructions may prevent solar radiation from reaching the solar cells of your panels. The Analysis menu has options available for you to compare electricity outputs panel by panel to determine if a panel should be relocated due to the reduction in solar input caused by shading.

*Determine the best tilt angle* – Solar panels are attached to racks so they can be positioned in rows on rooftops. The optimal tilt angle of these racks in New England would normally be 40-45° depending on the latitude of the location. However, as the tilt angle increases, the distance between rows would also need to increase to prevent inter-row shading. To maximize the available space on a flat rooftop, studies have shown that lowering the tilt angle to between 5 and 15° would be the optimal choice (See example in Figure 1.2). Each location is unique, and finding the right tilt angle and row spacing for your building will take careful analysis and testing to optimize your solar array design.

*Choose racking system* - In order for solar arrays to be able to resist the force of the wind, designs should be able to endure wind speeds of 120-160 mph on the East Coast (International Building Code IBC 1609, 2017). If the solar panels are not tilted, the force exerted by the wind will be minimal. If solar panels are tilted, the force of the wind on the panels increases significantly (Imagine a tent on the roof in a hurricane!). With an attached racking system, the solar panels are secured to the framing of the building by hardware that requires drilling holes in the roof and aligning racks with the internal structures (e.g., rafters, trusses) of the building. A ballasted racking system, on the other hand, uses heavy weights, typically concrete blocks, to anchor solar panel arrays on the roof.
Figure 1.3: A ballasted system (left) on the left with concrete blocks, attached system with metal supports (right).

The following table summarizes the advantages and disadvantages of the two racking systems.

<table>
<thead>
<tr>
<th>Racking Type</th>
<th>Wind performance</th>
<th>Tilt Angle Range</th>
<th>Weight</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attached Racking</td>
<td>Better wind performance</td>
<td>Higher tilt angle (5-45°)</td>
<td>3 lbs. per ft²</td>
<td>20% of the total cost of the panels</td>
</tr>
<tr>
<td>Ballasted Racking</td>
<td>May need advanced wind-loading evaluations</td>
<td>Lower tilt angle (0-15°)</td>
<td>4-6 lbs. per ft²</td>
<td>15% of the total cost of the panels</td>
</tr>
</tbody>
</table>

*Stay away from the edge of the roof* - It is important to follow the National Electrical Code (NEC) and International Fire Code (IFC) to ensure ample roof access and clear pathways so that fire fighters can safely put out fires. For example, the IFC requires a minimum 6-foot-wide clear perimeter around the edges of the roof (Figure 1.4).

Figure 1.4: International Fire Code requires a minimum of 6ft perimeter around the edges of a roof.
2. Design a Prototype Solar Array System

Step 1: Choose a Site and Import its Model

Choose a site from the Solarize Your World Site Inventory. (http://energy.concord.org/energy3d/sites.html). The sites are organized by towns/cities. Find your school building and click on the image to download the model. Then double click the model to open it in Energy3D.

Site name: _____________________________ Site address: ___________________________

Step 2: Analyze Solar Insolation Available for Your Site

You will need to conduct solar insolation analysis for the summer solstice, the spring or fall equinox, and the winter solstice in order to determine which areas of the roof are best to place your solar array.

1. Click on the “Calculate energy of the day” icon.

2. Set the date for the summer solstice (June 22). Adjust the Solar Irradiance heat map Contrast to see subtle differences in solar insolation on different areas of the roof. Try to use the same contrast setting for all three seasons to compare patterns across the seasons.

3. Look at pattern of solar insolation across different areas on the roof. Note which areas show a high degree of insolation (see scale) (good to place solar panels there) and those areas that don’t (cooler, areas to avoid placing panels).

4. Go to main menu → File → Copy Image, then Ctrl+V (Command+V on Macs) to paste each of the images in the table.

5. Repeat for the Vernal Equinox (March 22) and the Winter Solstice (December 22).
1. Which areas of the roof have the highest solar insolation in the winter? Explain why, using relevant science concepts (Hint: in the Solar Irradiance heat map on the winter solstice, look for the areas with the warmest color.).

_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________

2. In which season does the solar insolation distribute most evenly across different areas of the roof? Explain your answer using relevant science concepts (Hint: look for the season in which the colors differ the most across different areas of the roof.).

_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________

3. Considering the distribution of solar insolation on the roof across all the seasons, in which areas of the roof will you choose to place the solar panels?
Step 3: Note Obstructions

The **Existing Structures** constraint states, “Existing structures on the roof cannot be removed.” This means solar panels cannot be installed on the surface too close to existing structures. Look for these areas on the roof of the building and avoid them when placing your panels on the roof. *Please circle the areas of the roof that you may want to avoid placing solar panels.*

Paste an image of your work below.
Step 4: Keep Curb Appeal in Mind
The Curb Appeal criterion states, “The system must have minimal negative impact on the curb appeal of the building.” Look at your building from all sides and note where on the roof the panels will be visible from street level. Make every attempt in your array design not to diminish the attractiveness of the property and its surroundings when they are viewed from the street.

Step 5: Avoid the Edge of the Roof
The Fire Code Compliance constraint states, “There shall be a minimum 6- foot-wide (1.8 m) clear perimeter around the edges of the roof. Pathways shall be a straight line not less than 4 feet (1.3 m) away from rooftop structures.” A single solar panel is about 1.5 meters, or 5 feet, in length. To create a zone of avoidance along the roof edge as you situate your racks on the roof, place a solar panel along each edge of the building in proximity to your racks to mark the distance your racks should be away from the edge of the roof (see below). You can delete them after you have finished placing your racks on the roof.
Step 6: Select a Brand of Solar Panels

1. There are many types and brands of PV panels. You will have three different panels to choose from for your project. Look at the table below. As you can see, there are many variables to consider in choosing which panel to use in your design.

### Solar Panel Product Information

<table>
<thead>
<tr>
<th>Brand/Model</th>
<th>SunPower SPR-X21-345</th>
<th>LG LG300N1C-B3</th>
<th>Hyundai HiS-M280MI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost per Panel ($)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Small project (1-99 panels)</td>
<td>$1380</td>
<td>$1050</td>
<td>$840</td>
</tr>
<tr>
<td>Medium project (100-999 panels)</td>
<td>$690</td>
<td>$525</td>
<td>$420</td>
</tr>
<tr>
<td>Large project (&gt;1000 panels)</td>
<td>$345</td>
<td>$263</td>
<td>$210</td>
</tr>
<tr>
<td>Cell Efficiency (% of incoming energy converted to electricity)</td>
<td>21.5%</td>
<td>18.29%</td>
<td>14.43%</td>
</tr>
<tr>
<td>Size</td>
<td>1.04m × 1.55m</td>
<td>0.99m × 1.65m</td>
<td>0.99m × 1.96m</td>
</tr>
<tr>
<td>Shade Tolerance</td>
<td>High</td>
<td>Partial</td>
<td>Partial</td>
</tr>
<tr>
<td>Degradation Rate (decline in solar panel Output per year of operation)</td>
<td>0.25%</td>
<td>0.70%</td>
<td>1.00%</td>
</tr>
<tr>
<td>Warranty Period</td>
<td>25yrs</td>
<td>10yrs</td>
<td>10yrs</td>
</tr>
</tbody>
</table>

Data source: http://get.solardesigntool.com/

The cost of the panels includes most of the components of a solar electric system, installation services, warranty, etc. The cost per panel varies by the scale of the project. The larger the project, the lower the cost per panel is.

An important factor to weigh in your decision is cell efficiency, the portion of the incoming solar energy that is converted into electricity by solar panels. Notice that as the price of the panels increases, so does the cell efficiency. You might find yourself in a situation that calls for reducing one quality aspect, or amount of something (e.g., cost of the panels you use), in return for gaining another quality, aspect or amount (e.g. increased cell efficiency). This decision is called a trade-off and is an important engineering process. You will make trade-off decisions many times as you design your solar array.

Which of the three solar panels will you use to design your prototype array? Explain why you chose that brand over the other two. What trade offs did you make in coming to your decision?

_____________________________________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________

2. Go to the Icon menu and click Solar Rack icon and then click on the roof.

3. Set up the brand of solar panels: right-click any solar rack → Change Solar Panel Properties → Model → choose the brand from the dropdown menu → select “All Racks” → OK.
Step 7: Design the PV System

In this section, you will add a single rack to the roof and determine the type of rack you will use, the direction the panels will face, and the tilt angle of panels.

A. Optimize the orientation of solar panels
You can lay out solar cells within the rack in two different ways. The figures below show ways to arrange a rack. Depending on the shape of the roof, a certain layout may use the space better than the other. For example, a portrait arrangement may suit wider areas while landscape may be better for narrower areas.

1. Right-click any solar rack to bring up the submenu.
2. Select the “Change Solar Panel Properties” option and click “Orientation” to set the solar panel orientation to either portrait or landscape.

B. Set the rack size
The racks can be expanded to hold many more panels. Select the rack and use the white dots to expand the length and width of the rack. You can view the number of panels (and rows) on the rack in the information box on the right. In the example below, the rack contains 68 total panels in two rows on the rack. You can also see the size and extent of the complete rack (33.6 m X 3.3 m) as well as the tilt and azimuth direction.

<table>
<thead>
<tr>
<th>Rack (414)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size &amp; Position:</strong></td>
</tr>
<tr>
<td><strong>Angles:</strong></td>
</tr>
<tr>
<td><strong>Solar Panels:</strong></td>
</tr>
</tbody>
</table>
C. Set the base height for your racks
1. Right-click on the rack to bring up the submenu.
2. Go to “Base Height” and try a few values to ensure that the rack is as close to the roof (less than a meter) as possible without disappearing into the building structure.

D. Pick a rack system (Optional)
Go back to the rack systems table and decide which type of system you want to use for your prototype. Remember that if you choose a ballasted racking system, the tilt angle must be equal to or lower than 15 degrees. If you choose an attached racking system, the tilt angle can be set as high as 45 degrees.

E. Set tilt angle
Right-click on the solar rack to bring up the submenu → click “Tilt Angle” → set the tilt angle to a degree that you think would be optimal for your location and type of rack system you chose.

F. Set azimuthal angle
1. Click on the Heliodon ☉ icon. Zoom in so you can see your rack clearly.
2. Click on the Rotate ⬇ tool and to move the tilted face of the panel toward the sun’s path, as close to 180° as the configuration of the rooftop allows.
G. Produce a solar array design prototype
1. Now that you have determined the parameters of your rack and panel system, it’s time for you produce your initial plan. Copy (Ctrl+C) and paste (Ctrl+V) to create identical racks. Move your racks to positions on the roof that you have selected to give you the maximum energy output for each rack.

2. When your team has finished your initial solar array design, insert a screenshot of your completed plan in the space provided below and in your Design Journal, Iteration 1.

3. Ask your teacher and three other students to rate the visual appeal of your design:

<table>
<thead>
<tr>
<th>Rater</th>
<th>Least appealing</th>
<th>Most appealing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teacher</td>
<td>1 2 3 4 5 6 7</td>
<td></td>
</tr>
<tr>
<td>Student 1</td>
<td>1 2 3 4 5 6 7</td>
<td></td>
</tr>
<tr>
<td>Student 2</td>
<td>1 2 3 4 5 6 7</td>
<td></td>
</tr>
<tr>
<td>Student 3</td>
<td>1 2 3 4 5 6 7</td>
<td></td>
</tr>
</tbody>
</table>
3. Test Your Solution

Part 1: What is the Energy Yield of Your Preliminary Design?

1. Click the ground outside the foundations of your model so no building section is selected. (If you see white and orange edit points, that means a building section is selected.)

2. Go to main menu → Analysis → Solar Panels → Annual Yield Analysis of Solar Panels → Run;

3. The graph shows the energy output of your design over 12 months. The total energy output is shown on the upper right corner. Record this total in your Design Journal, Iteration 1.

4. When you close the graph, you will be prompted to save the results. Click “Yes” so you can compare results across future runs.

Part 2: Determine the Solar Offset of Your Design

1. Solar offset is the percentage of annual electricity consumption of the building that will be offset by the annual production of the solar energy system you designed. Calculate the solar offset of your first iteration by dividing the energy your array provides in one year by the energy consumed by users of the building in one year.

\[
\text{Solar Offset} = \frac{E_{\text{solar}}}{E_{\text{consumed}}} = \_\_\_\_\_\_\_\_\_\_\_\_\% 
\]

2. Record this value in your Design Journal for Iteration 1.
Part 3: Calculate the Total Project Cost

Set up and use Energy3D project cost calculator

The total cost of a surface-mounted system on flat roof consists of:
- the cost of solar panels, which is determined by the cost per panel and the total number of solar panels used in the system;
- the cost of solar racks, which is determined by the size of the rack and the height of the base;
- the cost of the racking system (optional).

Energy3D automatically calculates the project cost once you set up the cost per panel:

1. Determine the scale of the project: The number of solar panels ranges from 1 to 99 panels for small projects, 100 to 999 panels for medium-sized projects, and 1000 or more panels for large projects. What is the scale of this project? □ Small □ Medium □ Large

2. Look up the cost per panel in the Solar Panel Product Information sheet. The brand/model used in this project is__________________.

3. Based on the scale of the project, how much is the cost per panel? $_______________

4. Set up cost per panel in Energy3D: main menu → Edit → Custom Prices → PV Models → set up the cost per panel for the selected brand → OK

5. Read the project cost: click the ground outside the foundation of the building model. The project cost is displayed on bottom of the Information Panel.

6. Divide the total energy per year by your project cost to show the number of KWh produced in one year for each dollar expended for the project.

7. Enter all data into Iteration 1 of your Design Journal.
Part 4: Calculate Payback Period (Optional)

**Payback period** is the number of years required to recover the cost of an investment. To estimate the payback period of your design, you will need the project cost and the cumulative earnings made by the project in the coming years. The number of years it takes which the cumulative earnings to surpass the project cost is the payback period of the project.

The payback period is calculated by considering the following computations:

- Savings per year is calculated by multiplying the electricity (KWh) of the solar electric system by electricity price in that year.
- The production of energy of your solar array system is projected based on the first year production of the system and takes into account of a typical degradation rate of solar panels.
- The electricity price per year going forward is projected based on the price of electricity in year 1 with an estimated compound increase rate of 3.5% per year based on data from the last 30 years.

Follow the steps to estimate the payback period of your solar array project:

1. Open the Financial Modeling spreadsheet and enter the following data:
   - Project cost ($)
   - 1st Year production (kWh), which is the annual energy yield of your design
   - Annual degradation rate (%). Look up this value for the panel you used in your design in the Solar Panel Product Information sheet.
   - First-year electricity price per KWh: 10.5 cents
   - Increased cost of electricity price per year is estimated to be 3.50%

2. In the 30 years projection section, identify the year in which the cumulative earnings surpass the project cost. The payback period for this project is: ________ years

3. Add the payback period to your Design Journal for Iteration 1.
4. Redesign Your Solar Array System

Now that you have produced a prototype of your solar array system, it is time to step back and think about how it can be improved in terms of energy production, cost, and curb appeal. In the engineering design process, the work of honing the model, make small and large changes to achieve optimal results begins. Perform two iterations of your initial prototype and test your solution for each one.

Consider changing one or more of the following design variables in each of your two alternative array designs. Which combination of changes will result in your winning the bid and the Solar Design Challenge?

Keep trade-offs in mind when you change aspects of your array. If you add more panels, the project cost will increase and perhaps make your bid one of the highest in your class. If you change the type of panel you use, the energy efficiency will change. Will your trade-off strategies pay off and increase your annual energy production or decrease the cost of your project and lead to the winning bid?

**Design Variables**

1. Choose different areas of the roof to place solar panels
2. Choose a different solar panel product
3. Vary the spacing of the panels
4. Choose a different racking system and/or tilt the racks at different angles
5. Vary the numbers of solar panels
6. Arrange solar panels in various patterns
5. Document Your Work: Complete a Design Journal

As you iterate your solar array design, follow these steps to document your process.

1. Open the site model, go to main menu → File → Save As, add “_Iteration 1” to the original name and save the model. During this iteration, you will work on this file.

2. For each iteration, you need to report the following data on the forms that follow:
   1) Solar panel brand/model
   2) Total number of solar panels
   3) Annual energy yield
   4) Solar offset
   5) Project cost
   6) Annual energy per dollar spent
   7) Payback period
   8) Layout of the solar panels (insert a screenshot of your design)
   9) Your design ideas
   10) What you have learned from this iteration
**Iteration 1 – Prototype**

<table>
<thead>
<tr>
<th>Model name:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Solar panel brand/model:</td>
<td></td>
</tr>
<tr>
<td>Total number of solar panels:</td>
<td></td>
</tr>
<tr>
<td>Annual energy yield:</td>
<td></td>
</tr>
<tr>
<td>Solar offset:</td>
<td></td>
</tr>
<tr>
<td>Project cost:</td>
<td></td>
</tr>
<tr>
<td>Annual Energy per dollar spent</td>
<td></td>
</tr>
<tr>
<td>Payback period:</td>
<td></td>
</tr>
<tr>
<td>Average peer rating of curb appeal:</td>
<td></td>
</tr>
</tbody>
</table>

Insert a screenshot of the Energy3D model of your design:

Describe your design ideas for this iteration:

____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________

What have you learned from this iteration?

____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
## Iteration 2 – Redesign

<table>
<thead>
<tr>
<th>Model name:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Solar panel brand/model:</td>
<td></td>
</tr>
<tr>
<td>Total number of solar panels:</td>
<td></td>
</tr>
<tr>
<td>Annual energy yield:</td>
<td></td>
</tr>
<tr>
<td>Solar offset:</td>
<td></td>
</tr>
<tr>
<td>Project cost:</td>
<td></td>
</tr>
<tr>
<td>Annual Energy output per dollar spent</td>
<td></td>
</tr>
<tr>
<td>Payback period:</td>
<td></td>
</tr>
<tr>
<td>Average peer rating of curb appeal:</td>
<td></td>
</tr>
</tbody>
</table>

Insert a screenshot of the Energy3D model of your design:

---

Describe what changes you made in your design for this iteration:

______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________

What have you learned from this iteration in terms of electricity output, payback period, and curb appeal?

______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
Iteration 3 – Redesign

<table>
<thead>
<tr>
<th>Model name:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Solar panel brand/model:</td>
<td></td>
</tr>
<tr>
<td>Total number of solar panels:</td>
<td></td>
</tr>
<tr>
<td>Annual energy yield:</td>
<td></td>
</tr>
<tr>
<td>Solar offset:</td>
<td></td>
</tr>
<tr>
<td>Project cost:</td>
<td></td>
</tr>
<tr>
<td>Annual Energy per dollar spent</td>
<td></td>
</tr>
<tr>
<td>Payback period:</td>
<td></td>
</tr>
<tr>
<td>Average peer rating of curb appeal:</td>
<td></td>
</tr>
<tr>
<td>Insert a screenshot of the Energy3D model of your design:</td>
<td></td>
</tr>
</tbody>
</table>

Describe what changes you made in your design for this iteration:
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________

What have you learned from this iteration in terms of electricity output, payback period, and curb appeal?
______________________________________________________________________________
______________________________________________________________________________
6. Communicate Your Results

**Solar Challenge Final Report**

Submit the iteration you feel best satisfies the design criteria:

<table>
<thead>
<tr>
<th>Model name:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Solar panel brand/model:</td>
<td></td>
</tr>
<tr>
<td>Total number of solar panels:</td>
<td></td>
</tr>
<tr>
<td>Annual energy yield:</td>
<td></td>
</tr>
<tr>
<td>Solar offset:</td>
<td></td>
</tr>
<tr>
<td>Total project cost:</td>
<td></td>
</tr>
<tr>
<td>Annual Energy per dollar spent</td>
<td></td>
</tr>
<tr>
<td>Payback period (years):</td>
<td></td>
</tr>
<tr>
<td>Average peer rating of curb appeal:</td>
<td></td>
</tr>
</tbody>
</table>

Insert a screenshot of the Energy3D model of your optimized design.

Explain why you recommend it over other your prototype and other alternative designs?

______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
Identify and explain the factors that led to the recommendation of your final design.

______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________

What tradeoffs did you make to choose your final design solution?

______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
Appendices

Appendix 1. Site-Specific Design Requirements

Criteria:
1. **Solar offset**: The system should produce as much as electricity to offset the annual consumption of the building.
2. **Return on Investment**: The payback period of the project should be as short as possible.
3. **Curb appeal**: The system must have minimal negative impact on the curb appeal of the building.

Constraints:
1. **Budget**: The total cost of the system must not exceed the budget that your client is comfortable with.
2. **Existing structures**: Existing structures on the roof (e.g., ventilation hatches, HVAC modules) cannot be removed or covered.
3. **Rack base**: An attached racking system would be necessary if racks are tilted more than 15°. Attached racking systems can resist higher wind loads but also are more expensive to install. Ballasted racking systems can be used if tilt angle is less than 15°. The base height of a ballasted racking system should be less than 0.5 meters to support the weight of the system.
4. **Fire code compliance**.
   a. There shall be a minimum 6-foot-wide (1.8 m) clear perimeter around the edges of the roof.
   b. Pathways shall be a straight line not less than 4 feet (1.3 m) away from roof top structures.
5. **Inter-row distance**: Racks should be spaced close enough to maximize the roof area but also far enough apart to minimize shading.
Appendix 2. How much electricity does a building consume annually?

You can ask the building owner or manager to provide the information. If this information is not available, you can estimate the electricity consumption of the building using two pieces of information: 1) the floor or roof area of the building and 2) the average electricity consumption per unit floor area.

The floor area of the building can be estimated using the Energy3D model of the site.

1. In Energy3D, select a building section and look up its horizontal or roof area in Building section on the Information Panel;
2. Multiply the area by the number of floors to get the floor area of the building section;
3. Repeat the two steps above for all other building sections;
4. Add the floor areas of all buildings up to get the total floor or roof area of the building.

For example, the floor area of Hopkinton High School is estimated as follow:

<table>
<thead>
<tr>
<th>Building Section</th>
<th>Horizontal Area (m²)</th>
<th>Number of Floors</th>
<th>Floor Area = horizontal area × number of floors (m²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section 1</td>
<td>1148</td>
<td>1</td>
<td>1148</td>
</tr>
<tr>
<td>Section 2</td>
<td>965.9</td>
<td>1</td>
<td>965.9</td>
</tr>
<tr>
<td>Section 3</td>
<td>399.7</td>
<td>1</td>
<td>399.7</td>
</tr>
<tr>
<td>Section 4</td>
<td>2523.8</td>
<td>1</td>
<td>2523.8</td>
</tr>
<tr>
<td>Section 5</td>
<td>251.9</td>
<td>1</td>
<td>251.9</td>
</tr>
<tr>
<td>Section 6</td>
<td>250.4</td>
<td>1</td>
<td>250.4</td>
</tr>
<tr>
<td>Section 7</td>
<td>5707.23</td>
<td>1</td>
<td>5707.23</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td>11246.93</td>
</tr>
</tbody>
</table>

The average electricity consumption per unit floor area can be estimated using the 2012 Commercial Buildings Energy Consumption Survey (CBECS) results provided by the U.S. Energy Information Administration.

1. Open CBEC5 Total electricity consumption and intensities table
2. Identify the principal building activity of your site between row 15 to 32: Education;
3. Record the electricity consumption per square foot in column F for your site: 11kWh/ft²
4. Convert the above number to electricity consumption per square meters: 118.25kWh/m²
   (1 kWh/ft² = 10.75 kWh/m²).

Estimate the electricity consumption of the building by multiplying the floor area and the average electricity consumption per square meters:

\[ E_{\text{consumption}} = A_{\text{site}} \times E_{\text{consumption per m²}} = 11246.93 \text{ m²} \times 118.25 \text{ kWh/m²} = 1329949 \text{ kWh} \]